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Introduction

The Avant REM Speech represents a new era of precision in-situ verification for your office. Compact yet
rugged, this PC-Based system is USB powered and supports all ANSI and IEC Real Ear tests. The
software includes targets for DSL i/o 5.0 and NAL NL-1. A unique feature of the REM Speech is Live
Speech Mapping, MedRx’s in-situ method for getting the fitting right the first time, every time.

This manual assumes that the system hardware, software and drivers are installed and working properly.
Please refer to the MedRx Avant REM Speech Installation Manual for assistance.

The scope of this manual is to get you “up and running” with the Avant REM Speech System. Please
consult the interactive Help System within the software for more detailed information of features and
functionality. To access this tool, press the F1 key at any time, or click the Help icon or menu item with
your mouse.
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The AVANT REM Speech
Software

General Overview

The AVANT REM Speech software will either run as a part of the AVANT Software Suite (figure 1), or as
a stand-alone module (figure 2). The AVANT Software Suite can run stand-alone or from NOAH System
or the TIMS NOAH-Compatible Office System.

The software includes a context-sensitive interactive Help System. To access this tool, press the F1 key
at any time, or click the Help menu with your mouse. This will display additional information and
instructions for the specific section of the software you are working in.
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Figure 1 The AVANT Software Suite Main Screen Figure 2 The AVANT REM Speech Main Screen
Launching the REM Software
Stand Alone NOAH and TIMS
| ?g File View Window Help [ IUlher |
" T LR T
AR | Ay

AvantREM ‘ ‘ ‘ AVANT

AVANT| =% | |AVANT

Licensed to: - MedRx, Inc. - S4LES - SALES LICENSE, FOR INTERMAL

1. Double click the AVANT REM shortcut 1. Launch NOAH
on your Windows Desktop 2. Click the Real Ear Measurement Toolbar Icon
3. Alternately, from the Module Selection screen,
double click the AVANT REM icon
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Software Options

Basic Options

Several options are available which allow the user to customize the Avant REM Speech Software to

meet their needs.

Access these options from the File Menu on
the Avant REM Speech Main Screen as shown
below.

AvantREM

Function  Help

Clear Session Data
Print Setup...

Page Setup...
Advanced Opggs. .
Exit

The Options may also be accessed
from within the Avant REM Speech
main program by clicking on the

Options text menu as shown below

Fil=  Function Ear

Audio  Stimulus

AvantREM - Live Speech Mapping

The software allows you to set several default options as described below.

Options El
isw, | Live Speech | REM | MHAMLS | Tymp |
Plot Speech Spectum
I Vertical Giid I Canos
¥ Horizontal Giid
¥ Speech Sounds
Sight Language:
Style: [ Lines - e a—
Size: |30

¥ Hide Plots During Test

Default Ear: | Right hd

Options
View  Live Speech |REM | MHA/HLS | Tymp |
Live Speech
: ’—_|1 =
W Show Fall Sounds Defauk Lovel: |70 =
¥ Show Peak Sounds Smooth O/E:
Analyzer LTAS &
Octave Bands: [1/3 = Threshold (dB}:

¥ Interpolate Curves

Show Targets:

Dual Plat: |%/here Possible

I Reverse Ears

. ¥ Use Plot Antialiasing
¥ Maintain Plat Ratios

Plot Curves width: [Medium = |

]

Cancel |

Help

The View tab allows you
to set the default
appearance of the REM
test environment. Values
can be changed by using
the check boxes and pull-
down menus shown
above.

[NALNLT +] | Sewp |

I™ Show MCL
I~ Show Average UCL

=

Roling Window sec): |15 -

Smacth:

¥ Save Together With LSM

Merophone: [[iPebe 2]

&

Options

Default Stimulus:

Default Level: |70 E
Analyzer
Octave Bands: | 1/3 =

¥ Interpolate Curves

Show Targets:
NAL-NL1 | | Setup

W Show KEMARat |70 ~| dB
™ Show SPL Reference Curve

™ Show REUR on REAR

&

View | Live Spssch RENN MHAHLS | Tymp |

Average Readings: |5 -
Smocth Plots:

Sample Averaging Time fsec) [

ICRA Averaging Time (sec): 15 4;

Microphone: | Left Frobe =

,Tl Caneel ‘ Help ‘ ,Tl Caneel ‘ Help ‘
The Live Speech tab sets The REM tab sets the

the look and behavior of
the Live Speech Mapping
function. Use the Show
Targets  pull-down to
underlay DSL 5.0 or NAL
NL-1 targets below your
speech maps.
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default look and behavior

of conventional
Measurements.

Real Ear




Options E‘ Options El

View | Live Speech | REM MH%HLS | Tyme | View | Live Speech | REM | MHALS Tyme |
HLS
Defaut HLS Level: [El <) ¥ Show The Nom Area Scaling: [Ato
HLS Simulation: |MNormal - V¥ Auto Switch Modes

¥ Interpolate Curve
MHA
Default MHA Level: |50 4

MHA Smuiation: [Nomal ]

ok | coneel | Hep | [ ok | cencsl | Hep
The MHA/ HLS tab sets If your system has a
the default look and Tympanometer connected,
behavior of the Master this tab will assist in
Hearing Aid and Hearing configuring the look of the
Loss Simulator. display

NOTE: Remember, that more information is always available in the Interactive Help System by clicking
the Help Icon or pressing the F1 key.
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Advanced Options

The Advanced Options screen allows you to
configure your system to meet your individual
clinical needs. It also provides MedRx
Technical Support with tools for helping you
troubleshoot problems. Access this screen
from the File Menu on the Avant Main Screen
as shown to the right.

' AvantREM
5N Function Help
Clear Session Data

Print Setup...
Page Setup...

Options...

Exit

The key features of each tab are described below. For more in-depth information, consult the

interactive Help system within the software.

Advanced Options f'5_<\

General lAudiﬂ ] Widea 1 Tympannmetryl

[V Boost Priarity During Measurements CD-ROM Crrive: |E -

[ Multiple Manitars
™ Da Mot Disconnect from NOAH when Fitting
System Information

Device Manager | Language |

o]

Cancel | Help ‘

The General Tab configures the overall Avant
REM Speech behavior with respect to other
Windows programs, specifically NOAH.

Advanced Options b__<‘
General Mﬁ ‘ Video I Tympanometrﬂ
[T T QLR MedRx REM Audio hd
Input Device |Mede REM Audio ﬂ
Output Mucer: | MedRox REM Audio ~|
Input Mixer: [ MedRox REM Audio =]
Input Line: |:De§ault Line> j
Audio Properties
oK Cancel ‘ Help |

Use the Audio Tab to select the proper audio
device for your Avant REM. This tab also
provides access to the Windows Audio
controls.

Advanced Options rg‘ Advanced Options E‘
Geneml] Audio ] V'ﬁ wTympanomevy] Ganemw Audio I Video Twpﬁﬂﬁﬁﬁ’ 1

Ctoscope Input

BRC A (start VideoXpress. Captor= |

Tympanometer. |Tymp MT10 j
Source | Format ‘ Adjust |

Altemative Input

Device: [Not Available ~|

0K Cancel | Help | 0K | Cancel ‘ Help

If your system has a Video Otoscope, the
Video Tab allows you to select the appropriate
device driver
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Preparing for Testing

Connecting the Probes

Med INC

Precision Probe Microphones

www.medrx-usa.com

1. Locate the Probe Microphone case.

3. Connect the probe microphones to the AVANT REM
Speech main unit as shown above. The cables will only
connect when the white mark on the cable connector
aligns with the black mark on the main unit. DO NOT
force the connector on.

2. Carefully remove the probe microphones.
Note that these are precision instruments
and must be handled with care. Avoid
dropping them or striking them against hard
surfaces such as counter or desktops.

AR-I-MREMSW-5 Avant REM Speech Training Manual
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Bending the Ear Hook

5. Bend the
wire to follow

1. Remove the ear
hook from the

package. the contour
of the top of
2. Place behind the the pinna as
pinna. shown.
3. Hold wire so the
circular portion sits
just below the ear
lobe.
4. Mark the top of the
helix with your
thumb.
Attaching the Probe Microphone Assembly to the Ear Hook
1. Hold the probe 3. Carefully
microphone snap the
assembly so that wire loop
with the ear hook into the
facing the front of groove and
the head, the rotate the
microphone ports probe
face away from the microphone
patient. assembly so
the ear hook
2. Carefully align the in on top and
wire loop of the ear the black
hook with the microphone
groove in the cable is on
microphone the bottom.
assembly housing
as shown.
4. Connect the probe tube to the silver
metal sleeve of the probe microphone.
AR-I-MREMSW-5 Avant REM Speech Training Manual 10
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Calibrating the Probe Tube

For reasons of infection control and reliability of results, MedRx recommends that a new probe tube be
used with each patient. To ensure accurate measurements, it is necessary to calibrate the probe

tube each time it is replaced.

1. Place a new probe tube on the probe
microphone port as shown below.

In the Avant REM Speech software, click
e Function
e Calibrate

e Probe Tube

Position probe microphone between 19 and 39
inches from the loudspeaker and click Start.
The signal must be at least 70 dB to complete
a valid calibration. If the screen prompt
indicates the signal is too low, increase the
volume on the loudspeaker or moves the probe
microphone assembly closer and re-start the
calibration.

Repeat for the other probe. Valid calibrations
have the same approximate shape as the gray
target curve, but may contain a few spikes in
the very low or very high frequency area of the
response curve. This is acceptable.

If the measured calibration curve differs greatly
in shape or amplitude from the gray target
curve, replace the probe tube and re-calibrate.
If this does not correct the problem, contact
MedRx technical support at (888) 392-1234.

AR-I-MREMSW-5 Avant REM Speech Training Manual
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2. Place the probe tube between the calibration nibs as
shown. Be sure that the opening of the probe tube is
centered on the grill of the reference microphone.

; AvantREM
File BEyl=isW Help

Audiometry

Live Speech Mapping
Real Ear
Tympanometry
HLS/MHA

Speech Waterfall

Calibrate 4

Load Calibration Files |

Probe Calibration El

Microphone: ‘Highl Probe j

Reference Level: . 0 dg Level too low
- Place probe tube an top of the reference microphone.

- Start calibration.

- Adjust the volume so that the Ref. Level is above 70dB

Aborted

Wiew Help Claze
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Using the MedRx Probe Tube Stabilization System

To assist in maintaining proper probe tube position
during Live Speech Mapping and Real Ear
Measurement, MedRx has developed the Probe
Tube Stabilization System.

After bending the ear hook and attaching the probe
assembly and tube, slide the Stabilization System
onto the ear hook as shown. Align the larger hole
with the ear canal and thread the probe tube
through. The black tube depth marker should rest
just inside the larger hole.

Positioning the Speakers

Proper positioning of the
loudspeakers relative to
the patient’s hearing
aids is critical for making
accurate and repeatable
measurements. Seat the
patient so their ear is
between 19 and 39
inches from the
loudspeaker.

19”_39”

Make sure the grill of the loudspeaker is level with and directly in front of the patient’s head.

When using Live Speech inputs, position the patient so the mouth of the person speaking is in the same
position as the loudspeaker shown here.

AR-I-MREMSW-5 Avant REM Speech Training Manual 12
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Live Speech Mapping

Step-by-Step Guide to Live Speech Mapping

Ensure the Audiogram is Entered
Before making Live Speech Mapping measurements, the patient’s pure tone audiogram must be available
to the software. This can occur several ways:
1. The audiogram was automatically entered by MedRx Avant, Avant Audiometer or Avant A°D
software
2. The audiogram was manually entered into the NOAHaud 3 software and saved
3. The audiogram was entered using another manufacturer’s audiogram module

If none of these have occurred, you may manually enter the audiometric data into the AVANT REM
Speech software as follows:

5 AvantREM EX . AvantREM - Audiograms [B=[E]

Fie Function Help File Ear Audio Options... Tools Help

=R

HLIcB) i AP @’E

AVANT e Rl

Advanced Audiometric Technology

5 i

17
z

n
i

i

&

B " REMSpeech,

b
N

—

MedRyme {% " =~
_1‘25 250 500 7%D1 T‘EkZ il;q;mijZ]‘
1. Launch the audiometric module by clicking 2. Using your mouse, select the test ear
on the Audio button on the right side of the 3. Select the test type Air
Avant REM Speech main window. 4. Enter thresholds by clicking the intersection

points with the mouse.
5. Repeat for UCL (Bone and MCL optional)
6. Repeat steps 3-5 for the left ear

After the audiogram is entered, click the Back button to return to the Avant REM Speech Main screen.

1. From the AVANT REM Speech Main screen, click LSM
5D
LSM %

e 2. In the next Window. Click LSM again
Speech

Mlapping [

AR-I-MREMSW-5 Avant REM Speech Training Manual 13
Effective Date: 4/07/2014



Speech Mapping with Live Voice Inputs

+ AvantREM - Live Speech Mapping g@@l The ScreenShOt on the |eﬁ:
File Function Ear Audio Stimulus Options.., Tools Help ShOWS the LiVE Speech Mappmg
‘ ave | Hea® B0 o = T (LSM) window. The system was
T . designed to capture and display
‘ $ $ the human voice in the ear
120 | il | gz canal, so we recommend using

110

/ e | s the microphone input and peak

100 Pesks LTaS measurement.

90
Using the microphone allows
I measurement of both the

\ =N
[
e
/=N = | (P professional’s voice and that of
2 \/ /\/ — L the patient’s significant others.
&0 Open Fit E
4 To improve repeatability of
3 “ H H H| m IRET measurements, it is
il | =

a0

=1

recommended that the speaker
read a standard passage such
as the “Rainbow Passage” which
e AR . is provided in Appendix A.

SR 250 500 780 1k 15k Z 3k 4k Bk | ‘
| Start)

Frequency [ Hz )

NOTE: The screen shot above shows the MedRx Modified Speech Spectrum (Canoe). Itis also possible
to underlay DSL i/0 or NAL-NL1 targets on this screen. Click Options in the text menu bar on the top of
the screen to select and configure these underlays to meet the needs of your practice.

Speech Mapping with Recorded Inputs

2 For those who prefer a standard,
e ) ST repeatable stimulus for Speech
r ] f®] [Bn® | o | e PR Mgpping, the software prgvides
SPL ) ¢ [ 9 several digital audio files. These
12 ! | - LekEx | | FigntEer are accessed by clicking the File
o \/_H\/ : button on the right and then
I | s =% | selecting the desired track from
i NN ; ; the pull-down menu in the audio
I L /Y\ A sm‘;f: player.
g il N
5” J Once the desired track is
i ‘m%mm M”m selected, click the Start button to
TTZE 250 ‘ ‘EEIH 750 1k 18k 2k 3k 4 Bk Ek| begln measurlng- When enough
< = data is collected, click the Stop
button to stop the recording and
e :iﬂ:n;:.:;‘lnﬂm’sﬂﬁle " Ij measurement.
[=18=1 L] %« 4

It is also possible to use an audio CD, such as patient’s favorite music to perform Speech Mapping.
Simply click the CD button and then select a track as above. Using the sound level meter on the upper
right of the screen, adjust the output of the speaker to approximately 65 dB.

NOTE: The screen shot above shows the MedRx Modified Speech Spectrum (Canoe). It is also possible
to underlay DSL i/0 or NAL-NL1 targets on this screen. Click Options in the text menu bar on the top of
the screen to select and configure these underlays to meet the needs of your practice.
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The screen shot below provides an overview of all the tools and controls on the Live Speech Mapping
screen. For more information on these features, please consult the Interactive Help system by pressing
the F1 key or clicking the Help icon.

1. Reference Microphone Level

2. Ear selection

3. Measurement type
a. Peaks
b. LTAS

4. Input Selector

2. AvantREM - Live Speech Mapping

Open Fit Function

Test Interrupter

Discard, Help and Back buttons

Legend

. Reset Button

0. Target area — can be any of the following:
e MedRx Modified Speech Spectrum

e DSLilo

Hoo~NoO

e NAL-NL1

EEX

File Function Ear Audio Stmulus Options... Tools Help
HL Li 1 |
Audio m@) i <) 0 O——————
Mapping o 45 E5 85
SPL (48] ﬁ ﬁ
@ =
120 Left Ear Right Ear
—
. L\{\{/,AJ—""'—_-—-L @ mmmﬁmﬁ HHHHHHh
1004 Peaks LTAS
90
a0
T
[=11]
A +
40
an ‘_..——""/\.—-"x\
...--""'"'—,.'
j 128 280 500 B0 1k 15k 2 3k Bk 8k|
Frequency [Hz )
—  Air Conduction, Al=B3%, PTA=Z3
Uncomfortable level f) :
® X T
Dizcard izl Eizick
Copyright () 2000 - 2007 by MedFix, InE!
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Running Speech Mapping "On-Top” within NOAH

It is well established that verifying the output of hearing instruments in the patient’s ear will improve the
accuracy of the fitting. In the past, it has been difficult to verify these fittings since many real ear systems
have been disconnected from the fitting system. The Avant REM Speech system is tightly integrated with
NOAH, the industry standard for audiometric and fitting data storage and retrieval. The “on-top” mode of
the REM Speech software allows you to effortlessly alternate between measurement and fitting
adjustments.

1 Begin by opening the Avant REM
Speech software from within NOAH
as shown above.

0 AvantREM - Patient: Littledef, Ima

File Function Help

From the Avant REM Speech main
‘WL\\) screen, click the NOAH LSM button.
The REM Speech window will reduce
in size and “float” on top of the NOAH
screen.
T3 Open the fitting module from the
o {fc] B, 9, & [ NOAH Module Selection Screen.
Client Infarmation
8 =2 Module Selection
Fitti M Ot
[l itting 1 easurement] ther ] EM
il Audio |[HLEM || LsM @ @ W 5 i 6 i
- o]
’T MOAHf 3 SPL [d8) | | ‘ |
idstine 6.1 HEE  Use the text menus and green and
€ ReadHi | i optors.. |y Actvate oo~ fa & 1 2 | & Unknown track [01] = | g \I;:(rj]db(;j\[t\}?gsn’:r;lizesf:)%aetlc?]gl\kasrx)|ng
@ Right: Basic
sk | measurements. To make
Calculsted gain (50) He udm Stimulus - Options... Tools  Help E‘@lg‘ adJUStments to the hearlng
= L e instrument, click on the fitting module
@ . s window and modify the settings
@ i “\ according to the manufacturer’s
" - S - instructions, being sure to activate,
) vd 1ol '__Pf/\ apply or save the settings to the
- 1 AT instrument.
] 24 (42dB) A 80 o
125 250 S00 1k 2k 4k Bk - c&v&ﬂ/ AY:A\\(
o our o) ow e \\ Repeat this measure/adjust/measure
el L 5 = cycle until the fitting is optimized.
i HH | I
120 hd hd = 125 250 500 780 1 15k 2 A 4 Bk ‘
8 7 - Ei
100 \/\N\/\\\ tequency [Hz ]

Completing the On-Top Mode Process

1. Save the fitting and close the fitting module as usual

2. Click the Back icon

3. Click the Exit icon

4. Click Yes to save the session to NOAH

AR-I-MREMSW-5 Avant REM Speech Training Manual 16
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MedRx Live Speech Mapping Protocol

Unlike other products, the Avant REM Speech system places full control over the measurement

environment firmly in the hands of the hearing care professional. The system is powerful, yet extremely

flexible, allowing each provider to use Live Speech Mapping in a way that compliments their practice style
rather than compromising it.

In order to get you “up and running” with the Avant REM Speech system, MedRx has developed the
following protocol. This simple procedure has been found to be effective with both audiologists and
hearing instrument specialists. After mastering the basic operation of the system utilized in this protocol,
you are encouraged to further expand your use of Live Speech Mapping in your practice. Feature-
specific help is available by simply pressing the F1 key or clicking on the Help icon or text menu.

1.

IS

Basic Diagnostics
a. Using your audiometer and NOAH, measure and record the following values:
b. Pure Tone Air and Bone conduction thresholds
c. Narrow Band Noise or Pure Tone UCL at 500, 2000 and 3000 Hz
d. Other tests if needed in your practice or jurisdiction

Complete a careful otoscopic examination as instructed by the manufacturer of your otoscope.

a. For MedRx Video Otoscopes, refer to the Help system within the software by pressing
the F1 key or clicking the Help icon or text menu

Position patient as described earlier in this manual.

Calibrate Probe Tube as described above.
Measure and place the probe tube in the ear canal.
Complete a Live Speech Mapping measurement UNAIDED
a. Microphone input
b. Peak Measures
c. 1/3 Octave resolution

Carefully place the hearing instrument in the ear without disturbing the probe tube.
Complete a Live Speech Mapping measurement AIDED.
Using the On Top Mode, make any adjustments needed to the hearing instrument so that:

a. The LSM curve for Quiet Speech (50 to 60 dB) is at the bottom of the white modified
speech spectrum (canoe)

b. The LSM curve for raised vocal effort speech is in the upper third of the space between

threshold and UCL

c. The LSM curve for loud sounds (very loud speech, clapping hands, etc) is approximately

10 dB below the UCL curve.

AR-I-MREMSW-5 Avant REM Speech Training Manual
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Real Ear Measurements

In addition to Live Speech Mapping, the Avant REM Speech supports all conventional Real Ear
Measurements (REM). All these tests are accessed from the main REM screen.

To begin, click the E; ¥ [% button on the right of the Avant REM Speech main screen.
REM

In general, REM tasks are performed as follows:

= AvantREM - Unaided Response - Patient; Sclerosis, Oto (%)

File Function Ear Audio Target Stimulus  Options,.. Tools Help

‘ﬂ w RELIR 1HEUE

REIG

‘HEARHREAE| ‘REEIRHREEIB| ‘ 0 HREED‘

1. Select the REM test you wish

. ~ mds:lzz $ -9 to perform from the top row of
B LeitEar | | Right Ear buttons
120 [ — 2. Select the test ear
1o i ol |t 3. Select the test stimulus
100 N 4. Click Start. The test will stop
@ yAS 13 5‘:""': m@F itself after sufficient data has
m j[ i = been collected and averaged.
70 — \ - 5. If you wish to delete a curve,
0 i simply select it with your
50 . ‘ mouse and then click the
0 i Discard icon or press the
a0 Delete key.
ThE ok bk sk & ] 6. When all measurements are
v ey (] complete, click the Back arrow
5 -5 to return to the Avant REM
—— @ Speech Main Screen.
KEWAR: @ x I} \,_I
Discard 12 Elzick

To activate specific REM tests, click the buttons as follows:

Opens the audiometry data entry screen. Use this if audiometry has not been previously
Audio measured and entered into NOAH.

. Allows the selection of gain-based fitting rules to generate targets. The following rules are
FittingRx supported: ¥ Gain, POGO |, POGO lI, Berger, 1/3 Gain, NAL-RP, FIG6, DSL, NAL-NL1

Real Ear Unaided Response - Measures the additive effect of the ear canal’s resonance
REUR to a stimulus. Reported as dB SPL of output.

Real Ear Unaided Gain - Measures the additive effect of the ear canal’s resonance to a
stimulus. Reported as dB SPL of gain. If a real ear unaided response (REUR) curve has

REUG : . . ! :

been measured, the corresponding real ear unaided gain curve is automatically plotted to

the REUG screen.

The difference between the REUG and the REAG is called the Real Ear Insertion Gain
REIG (REIG). This Insertion Gain information is used to compare to the target gain curve
selected for the client.

The Real Ear Aided Response (REAR) is the sound pressure level in the ear canal
measured with the probe microphone close to the eardrum and the operating hearing
REAR instrument inserted in the ear and turned on. ANSI defines REAR as the SPL, as a
function of frequency, at a specified measurement point in the ear canal for a specified
sound field, with the hearing aid in place and turned on.

The REAG is simply the REAR expressed as gain rather than SPL. Selecting REAG
REAG allows you to see the gain at each frequency for each of the REAR curves measured.

AR-I-MREMSW-5 Avant REM Speech Training Manual
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REDR

REOR measures the effect on the natural external ear effects resulting from inserting an
ear mold or a hearing instrument, before it is turned on, into the ear canal. The REOR |
also referred to as Insertion Loss REOR s also useful for validating the effectiveness of
venting or canal length changes to the mold.

REDG

The Real Ear Occluded Gain (REOG) is the difference in decibels, as a function of
frequency, between SPL in the ear canal and SPL at the reference microphone at the
entrance of the ear canal with the hearing aid in the ear and turned off. For each REOR
measurement curve, the corresponding REOG curve is calculated and automatically
plotted to the REOG screen. The REOG function is useful in determining the acoustic seal
of a hearing aid, relative to a sound field outside the ear.

0/

Some clients report they seem like they are “speaking in a barrel” or “feel blocked up”.
These are signs of a build up of low frequency energy in the ear canal. This excessive
occlusion can be measured objectively in the Occlusion Effect task.

RELL

The Real Ear to Coupler Difference (RECD) is used to simulate real ear measurements by
coupler measurements and is useful when fitting children or “difficult” to fit patients. See
the section on RECD later in this manual for more detail.

Sample REM Screens

The Avant REM Speech system supports all current ANSI and IEC Real Ear Measurements.
The screenshots below were made using the software defaults. These defaults set the test
parameters for each test according to these standards, however the test environment is fully
configurable to meet individual professional’s needs.
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Additional Tests & Features

Real Ear to Coupler Difference (RECD)

The Real Ear to Coupler Difference (RECD) is used to simulate real ear measurements by coupler
measurements and is useful when fitting children or “difficult” to fit patients. The RECD values are used
as a correction to coupler measures for that client’s hearing instruments. By performing all subsequent
measures in the coupler and applying the RECD corrections to the coupler measures, the “real ear”
factors are incorporated into the results. The resulting simulated measurements provide information to
select and make adjustments to the hearing instrument and verify adjustments in the hearing instrument
test box rather than in the uncooperative client’s ear. This is particularly important in the case of children,
whose small volume ear canals enhance high frequency amplification more so than in average adults.
This is an essential consideration in determining the maximum output of the hearing instrument.

If RECD data is present, the software will display an option to choose between Ear or Coupler
measurement on all Real Ear screens where measurements in a coupler are appropriate.

There are two ways to measure the REAR response: using an insert headphone or a hearing instrument.
If a hearing instrument is used, its volume control setting and other parameters should remain the same
for both REAR and coupler measurements. It is also recommended to set the volume control to
moderate, and turn the compression and noise reduction circuits off.

How to perform the RECD task

First, perform the REAR task to obtain a REAR curve. This can be measured with a hearing instrument
or an insert earphone.

REAR with a hearing instrument
e Adjust volume of the hearing instrument to comfortable listening level.
It is also recommended to turn the compression and noise reduction

circuits off.

e Position the client less than one meter from the speaker and facing
the speaker.

e Place the hearing instrument and the probe microphone tube as for all
REM measurements.

e Select START to open the measurement type selection screen.
e Choose the REAR with a Hearing Aid option.

e Select OK to begin the test and wait until it concludes.
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REAR with an insert headphone

e Place the probe microphone tube as for all REM measurements but
use the insert headphone instead of a hearing instrument.

e Select START to open the measurement type selection screen.

e Choose the REAR with an Insert Headphone option.

e Select OK to begin the test and wait until it completes.

Coupler response
When the REAR is complete, you are prompted to perform a coupler response.

e Attach the hearing instrument or the insert headphone (must be the
same as in the REAR test) to the appropriate coupler and place the
probe tube inside the coupler.

e If a hearing instrument is used, be sure to perform this measurement
at the same volume control setting as the first measurement.

e Select START to open the measurement type selection screen.

e Choose the Coupler Response option or Use Stored to skip the
measurement (see note below.)

e Select OK and wait until the test completes.
e The calculated RECD curve is automatically displayed on the screen

and is stored in memory for correction of subsequent test box
measurements made from the RECD function.

Note: If the REAR and the coupler response were measured with the insert headphone, the program
saves the coupler response curve for later use. In this case to obtain another RECD, only REAR with
insert headphone measurement is necessary. This is possible because the coupler response does not
change provided that neither the coupler nor the insert earphone has changed.
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Measuring Acoustic Feedback

Feedback (whistling, howling) is one of the most common complaints of hearing instrument users. Even
though many modern hearing instruments have sophisticated feedback management systems, knowing
exactly where the feedback is occurring can greatly reduce the time required to resolve the problem. The
Avant REM Speech system does an excellent job measuring and displaying acoustic feedback.

SFL@)

1. Place the calibrated probe tube in the ear canal as instructed
above.
\D\/’\u——u 2. Place the hearing instrument in the ear without disturbing the
| probe tube.
3. Begin a Live Speech Mapping session as instructed above.

/ﬂ\/ | 4. When feedback is present, click the Start button.
| ¥R 5. Acoustic feedback appears as a large spike in the LSM
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Hearing Loss Simulator

The Hearing Loss Simulator demonstrates the effect of the client’s hearing loss for the significant
third party. The program attenuates an input signal to simulate the audiogram. The third party
listens to the free field speakers. The third party can hear how their own voice is distorted by the
hearing loss when the Record input option is used.

The Hearing Loss Simulator requires the client’'s Audiogram data. This data can be manually entered in
the Audio screen of this or any other task.

How to perform the Hearing Loss Simulator task
e Select the Hearing Loss Simulator tab on the toolbar.
e Enter the Audiogram values manually if the data is not automatically imported to this screen.

e Select the input signal type: Mic, File or Record. Select the track and the Play button on the
control panel. See below for instructions on how to use the Record option.

e The HLS output is directed to the free field loudspeakers.
e Select Normal to play the input signal as a person with normal hearing would perceive it. Select

Simulated to turn on the simulation of the client's hearing loss. Toggle between these selections
as necessary.
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e The Reset option restores the audiogram to the original state. Use this option if you have
modified the audiogram but want to undo the changes. The changes to the Audiogram that are
made on the HLS screen are temporary and will not affect the client's original audiometry record.

e Avolume control adjustment bar allows for manual adjustment of the output levelof the freefield
speakers.

e To stop the playback, select the Stop button on the player.
Note: It is recommended you use a variety of tracks from the list to demonstrate the hearing loss.
Record Input Option

This option allows recording and playing back of the voice of the third party.

Master Hearing Aid

Master Hearing Aid is an alternative to using a stock hearing aid to demonstrate the benefits of
amplification to an inexperienced user. The system applies the fitting rules by default to the patient's
audiogram and simulates a hearing aid. The patient listens to this signal through the headphones.
Options for editing the gain applied to the audiogram are provided.

About the Master Hearing Aid Display

The Master Hearing Aid screen displays a graph with dB Gain on the vertical axis and Frequency in Hz
on the horizontal axis. The plot on the graph represents the gain applied to the patient’s Audiogram. The
NAL-RP is applied by default. A new rule can be selected from the list on the right side of the display. A
volume adjustment bar allows for manual adjustment of the output level. The control panel on the right of
the display provides options for input signal source and the task icons for Normal and Simulate.

The Master Hearing Aid applies gain separately for each ear. If audiogram values are entered for the left
and right ear, the selected fitting rules will be applied to each ear separately. Different rules may be
entered for different ears (i.e. NAL-RP for left ear and BERGER for right ear). If an audiogram is entered
only for one ear, the gain will not be adjusted for the opposite ear and the sound for that ear will be
normal.

If Binaural mode is selected, the sound will be heard from both channels (left and right). If Monaural
mode is selected, the sound will be heard only from the channel corresponding to the active ear when the
channel for the opposite ear will be muted.

Input signal

Live voice (microphone) allows you to use the talk-over microphone for live speech input to the inserts.
The clinician or significant third party can speak into the microphone for this activity. Note: there is a
processing delay between the input and playback. Make sure that the client cannot hear the voice directly
but only through the headset. If this is not possible, use the Recorder (describer below) to simulate
speech input.

File allows the user to play sound files. The program supports MP3 and WAV files and comes with pre-
set MedRx Sounds Sensations set of files. After the option is activated, use the player panel to control the
playback.

CD allows the user to play music CDs. After the option is activated, use the player panel to control the
playback.

Record input mode allows the clinician or third party to record a sample of their speech which can then
be replayed for repeat comparisons under different amplification conditions for the patient. Refer to the
interactive Help system by pressing F1 or clicking the Help icon to learn more about the recorder.
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How to use the Master Hearing Aid:

1.

2.

Select the Master Hearing Aid (MHA) icon from the main screen.

Enter the Audiogram values manually if the data is not automatically imported to this screen.
Select the input signal type: File, CD, Mic, or Record.

Select Monaural or Binaural

Select the Normal icon, which will send the input signal through to the inserts without

modification. The patient is listening to the signal without any amplification benefit. Select the
Simulate icon to modify the input signal according to the selected rule. This selection allows the

patient to hear the benefits of amplification. Toggle between these two selections as necessary.

If the simulated frequency response needs to be adjusted, based on feedback from the patient,
manually edit the response by clicking on the gain curve at the desired frequency and new gain
level. The gain curve of the selected test ear on the control panel can be edited. To edit the
other ear, click the appropriate test ear icon on the control panel first.

Hint: Use the track return icon on the player control panel to replay one track continuously.

The Reset option restores the rule to the original state. Use this option if you have modified the rule but
want to undo the changes.
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Printing

Printing within the Avant REM Speech software is very simple.

AvantREM - Live Speech Mapping

FE8 Function Ear Audio Stimulus  Options, .,

Start EMTER i
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Save

Clear Session Data

Print Setup...
Page Setup...
Prink Preview
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o Back. Chrl-Back
Exit alk-F4
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From the File menu, click one of the following
options:

Print Setup — selects the printer you want the report
to be sent to. Avant REM Speech prints to any
installed Windows printer.

Page Setup — Allows you to set margin sizes and
the default text header for your reports.

Print Preview — Shows you what your report will
look like before you print it.

Print — Sends the report to the printer.
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Limited Warranty

MedRx, Inc warrants the AVANT REM Speech ™ System to be free from defects in material and
workmanship for one year from the time of purchase. If this system fails to perform as specified
during this period, the purchaser is responsible for calling MedRx at (888) 392-1234. The
company's representative will advise the owner to either return specific components or the entire
system to:

MedRXx, Inc.
1200 Starkey Road #105
Largo, FL 33771

MedRx will repair or replace any defective parts, fully test the system and/or components and
ship the system promptly back to the owner. There is no cost for this warranty service, provided
the system is one year old or less and has not been misused, abused or damaged. Such damage
includes, but is not limited to, dropping, exposure to excessive heat greater than 100°F and
water/liquid damage.

Repair or replacement of the system as provided under this warranty is the sole and exclusive
remedy of the purchaser. MedRx shall not be liable for any consequential or incidental damages,
or for breach of any express or implied warranty. Except to the extent of applicable law, any
implied warranty, merchantability or fitness of this product is limited to the duration of this
warranty.

MedRx will, at its discretion, service and repair out of warranty components at the purchaser's
request, charging for parts and labor as necessary.

The limited warranty is deemed void if software or hardware is installed on the Avant REM
Speech which is not pre-approved by MedRx, Inc. Approved software includes NOAH™ and
HIMSA approved hearing aid manufacturer programming modules for fitting hearing aids.

MedRyx, Inc. is not responsible for problems resulting from installation of unapproved software or
hardware. In the event of unapproved software or hardware installed on the system causing a
conflict with the Avant REM Speech functions, MedRx will service the problem for a fee to be
determined at the time of service.

Consult your MedRx Technical support member for other alternatives for back up.
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